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USER GUIDE 
 

AD ASTRA PROCEDURE FOR PULLING PREFERENCES 
 

Description:  This user guide shall be used for navigation on how to pull a current preference list inside Ad Astra 

from the reports tab.  

Please contact the Office of the University Registrar (OUR) at 832-842-5775 if you have any questions after 

reading this procedure and viewing the training videos. 

 

This procedure will be located and continually updated for future reference on the Ad Astra web page within 

the “Written Procedures” section.  

 

PART 1:  LEGEND OF EACH USED FIELD IN THE PREFERENCE EXCEL FILE FOR FUTURE REFERENCE.  Page 2 

PART 2:  AD ASTRA WEBSITE URL.  Page 3 

PART 3:  LOCATION OF THE PREFERENCES REPORT WITHIN AD ASTRA. Page 4 

PART 4:  EXPORTING THE DATA FROM AD ASTRA INTO AN EXCEL FILE. Page 5 

PART 5:  FILTERING YOUR EXCEL PREFERENCE FILE. Page 9 

PART 6:  LOOKING UP PREFERENCE INFORMATION FOR A SPECIFIC COURSE AND UNDERSTANDING WHAT YOU ARE SEEING.  Page 14 

 

 

 

 

 

 

 

 

 

http://www.uh.edu/about/offices/enrollment-services/registrar/ad-astra
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PART 1:  LEGEND OF EACH USED FIELD IN THE PREFERENCE EXCEL FILE FOR FUTURE REFERENCE  

[PRINT this page for a handy reference]: 

Column Field Name Description 

A  INSTITUTION   Always “University of Houston – Main”. 

B PREFERENCERULES_SEQUENCE Represents the temporary rule number has been assigned.  This number shifts 
when a preference rule is created above it and is never meant to be a 
permanent assignment.  Once course could be a part of multiple preference 
rules.  Several courses can be a part of one rule if they all have the same 
needs.  Remember the order number is not important when it comes to 
finding room assignments during optimization.  At the time this procedure 
was created, here is some logic to how rules are placed in order: 

Rule numbers  
1-22 

Massive preferences based on region so courses not 
provided specific preferences at least stayed in your region.  
Example:  Rule 1 currently takes up 61 lines in the excel file 
as it represents a broad preference for every course in the 
ARCH college, both lectures and seminar versions to keep all 
of these type of classes inside the Architecture building and 
in appropriate room types. 

Rule numbers  
23-62 

Broad subject preferences in alpha order submitted by 
schedulers. 

Rule numbers  
63-377 

Course preferences in alpha order submitted by schedulers. 

C/D PREFERENCESETS_NAME/ 
PREFERENCESETS_DESCRIPTION   

These two fields will always be the same and always represent a specific rule 
set for a term and year of that term (IE, Spring 2015). 

E CAMPUS_NAME Field will always be null since everything is UH Main. 

F MEETINGTYPES_NAME Currently we have preferences for “LEC” Lecture, “LAB” Lab, and “SEM” 
Seminar. 

G DELIVERYMETHOD_NAME Currently, field is always null as we only create preferences for face to face 
classes. 

H SUBJECTS_SUBJECTCODE Field always populated whether the preference is for just a broad subject 
code or a specific course for easy filtering. 

I/J COURSES_SUBJECT_SUBJECTCO
DE/ 
COURSES_COURSENUMBER 

These two fields are tied to each other.  When a scheduler submits a 
preference for GEOL 1102, fields H and I will say GEOL and field J will say 
1102.  To filter properly, it is recommended that you use file H to filter the 
subject and field J to filter the specific course number of that subject. 

M ROOMTYPES_NAME Used to build preferences including specific room type needs such as 
laboratory, special class lab, lecture classroom, seminar room, etc. 

N FEATURES_NAME Data projector, computer, etc. are features that are tracked and preferences 
can be built around. 

O REGIONS_NAME NSM, CLASS, TECH, etc. are all regions that preferences can be built around. 

P/Q BUILDINGCODE/ 
BUILDINGS_NAME 

Building’s abbreviation code and long name used if a preference for an entire 
building (not specific rooms) was created. 

R/S BUILDINGCODE(1)/ 
ROOMNUMBER 

Building’s abbreviation code and room number(s) specified if a preference for 
a specific building’s room(s) was created. 

U WEIGHT Almost every preference you can ask for a subject/course can have a weight 
associated with it.  For example, the use of an auditorium may be 10 (wanted 
to use the most for your course), lecture classroom 9 (a little less wanted), 
and seminar room 2 (wanted least). 

V QTY This field stands for the quantity of a feature preferred.  We currently do not 
use this feature. 

W ISREQUIRED Most preferences are “required” or the class will not place during the initial 
optimization run.  If you see a “1” here, that acts like a true or yes statement. 

X/Y ISEXCLUDED/ 
ISBLOCKED  

We do not use these features. 
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PART 2:  AD ASTRA WEBSITE URL.  

Open the following website to access Ad Astra and enter your login credentials.   

Production- https://astraschedule.uh.edu/Astra00730/Portal/GuestPortal.aspx 

 

You are able to access Ad Astra via this web address using any web browser, tablet (iPad), or smart phone that 

has access to the internet.  

Note:  If you do not remember your login information in the future, please contact OUR for assistance.  Should you click 

on something that you do not have the security to view or if an error occurs, click on the “University of Houston” logo 

(as seen in the picture below) to get back to the home page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://astraschedule.uh.edu/Astra00730/Portal/GuestPortal.aspx
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PART 3:  LOCATION OF THE PREFERENCES REPORT WITHIN AD ASTRA. 

Now that you are logged in, locate the “Reporting” tab available for an UH faculty or staff member as shown below: 

 

A.  Click on the “Reporting” tab and “Reports” link. 

 

 
 

B. From the report list, locate and click the report link titled “UHS Preference Data”. 
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PART 4:  EXPORTING THE DATA FROM AD ASTRA INTO AN EXCEL FILE. 

Unlike all other reports in Astra, the preference report is not usable in regular report form within Ad Astra and MUST be 

exported into an Excel file.  Take the following actions to export the data into an excel file: 

 

A. Locate and click on the export icon (looks like a floppy disk on top left corner of report screen) highlighted 

below.  

 

B. The export menu should have popped up.   

1. click the drop down arrow off the export menu.   

2. click the file format of “Microsoft Excel (97-2003) Data-Only”.   

note: If you do not select the Excel format with “Data-Only”, then you will not receive a usable file.
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C. Click the “Export” button. 

 

D. You may now click the “Save” first (for best results) and then “Open”.  Excel should now open up. (this may vary 

depending on your browser) 
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E. If your document opens in “Protected View,” Click “Enable Editing”. 

 
 

F. Now it is time to save the file onto your desktop (or whatever file you choose).  Take the following actions: 

1.  Click “File” from the Excel’s top tool bar. 

2. Click “Save As”. 

3. Choose/click on the folder you wish the file to be placed (suggested: create/use a folder to hold your 

preference file for quick retrieval). 
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4. Under the “Save as type:” menu, click the drop down menu and select “Excel Workbook” (specifically, 

change from “Excel 97-2003” to “Excel Workbook”. 

   

 

5. Name the file to your liking such as “Schedule Preferences Spring 2014 12-9-13 3pm” and click save. 
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PART 5:  FILTERING YOUR EXCEL PREFERENCE FILE. 

Now that you have your preference file, it is critical that you know how to filter and review the specific pieces of 

information you wish to go over.  Please take the following actions after you download and save it to your computer: 

A. Let’s set the most efficient layout view of your Excel file first. 

 

1.  Click the triangle in the picture below to highlight the entire Excel file (alternate keystroke: <CTRL> ‘A’). 

 
 

2. From the “Home” tab, click the “Format” button.   

 
 

3. From the menu that pops open, click “AutoFit Column Width”. 
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4. Next lets freeze the top row so you can always see which field (column) you are looking at, regardless of 

how you filter or scroll the records by taking the following actions: 

 

a) From the “View” tab, click the “Freeze Panes” button. 

 
 

b) From the menu that pops open, click “Freeze Top Row”. 

 
 

5. Filtering is the most critical part of the layout setup.  To add filters, take the following actions: 

a) From the “Home” tab, click on the “Sort & Filter” button. 

 
b) From the menu that pops open, click “Filter”. 
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Note:  Every field (column) should now have a triangle available for you to click on and filter 

what it is you wish to view (as shown highlighted). 

 
 

6. Click the “Save” icon so you will not have to take these same action for this specific file again.  If you 

accidently delete something or shift items out of order, you can always close the file and reopen to this 

point here if you take the time to complete this crucial step. 

 
 

B. Now that the layout view of your file is ideal, let’s filter out exactly what you want to see by choosing one of the 

following categories: 

 

1. Preference Set Name  

There are multiple semester preference sets included in this one file and the file will only get larger as 

time goes on. We want to filter to be able to focus on the semester we are preparing to schedule or 

include other specific semesters as a reference/guide, if desired. 

a) Locate excel colum C titled “PREFERENCESETS_NAME”. 

 
b) Click on the filter triangle for this specific field. 
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c) From the menu that pops open, make sure only the term you wish to view is selected/checked.  

You may either click “Select All” to uncheck all selected items and then click on the specific 

term you wish to view OR unselect individually all undesired terms. 

 

FROM:      TO: 

 
 

d) Click “OK”.  Now only data from the preference set titled “Spring 2015 Preferences for 

Optimization” is selected. 
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2. Meeting Type 

Lectures (LEC), Labs (LAB), and Seminars (SEM) are typically the only meeting types included in 

preferences we create.  This is a great add-on filter, but can be difficult to use by itself since we have so 

many preferences. 

 

a) Locate Excel column F titled “MEETINGTYPES_NAME”. 

b) Click on the filter triangle for this specific field. 

c) From the menu that pops open, make sure only the meeting type you wish to view is 

selected/checked.  You may either click “Select All” to uncheck all selected items and then click 

on the specific meeting type you wish to view OR unselect individually all undesired meeting 

types. 

d) Click “OK”.  Now only data from the desired meeting type is selected. 

 

3. Subjects 

Many preferences are built off of the subject code (IE, BIOL, ECON, MATH, etc.) alone and the 

preference is built for all courses in that subject code. 

 

a) Locate Excel column H titled “SUBJECTS_SUBJECTCODE”. 

b) Click on the filter triangle for this specific field. 

c) From the menu that pops open, make sure only the subject(s) you wish to view is 

selected/checked.  You may either click “Select All” to uncheck all selected items and then click 

on the specific subject(s) you wish to view OR unselect individually all undesired subjects. 

d) Click “OK”.  Now only data from the desired subject(s) is selected. 

 

4. Courses 

The majority of preferences are built off of a specific subject’s course number. 

a) Locate Excel columns I titled “COURSES_SUBJECT_SUBJECTCODE” and J titled 

“COURSES_COURSENUMBER”. 

b) Click on the filter triangle for both of these specific fields. 

c) From the menu that pops open, make sure only the subject(s) and course number(s) you wish 

to view is selected/checked.  You may either click “Select All” to uncheck all selected items and 

then click on the specific subject(s) and course number(s) you wish to view. 

d) Click “OK”.  Now only data from the desired subject(s) and course number(s) is selected. 

 

Note:  Room Type (column M), Features (column N), Regions (column O), Building Code (column P), and 

Room Number (column S).  The preference requests submitted must have include information from 

these fields in Ad Astra in order for it to populate in this file.   
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PART 6:  LOOKING UP PREFERENCE INFORMATION FOR A SPECIFIC COURSE AND UNDERSTANDING WHAT YOU ARE SEEING. 

Now that you have some direction on how to filter your preference file, we will now look for an individual course and go 

over what each individual field means.  Take the following action in looking up what the current preferences are listed 

for POLS 1333 (feel free to use whatever course you like). 

A. Go to field “SUBJECTS_SUBJECTCODE” (column H), and filter the subject “POLS”. 

B. Go to field “COURSES_COURSENUMBER ” (column J), and filter the course number “1333”.   

Note:  Please notice that in the image of the excel file below, only one preference rule is created for POLS 1333 (field 

“PREFERENCERULES_SEQUENCE” (column B) says 367 for every row, but there are 10 individual Excel rows.   

 

Why are there 10 individual excel rows?  Listed below is an image of all the preferences for POLS 1333.  Each individual 

preference item receives their own excel row.  In this example for this one class, the file shows you the preferences: 

 Media Link – Weight 10 

 McElhinney Hall – Weight 9 (since only 1 building listed the actual number used does not matter). 

 Auditorium – Weight 10 

 Lecture Classroom – Weight 9 (so the optimizer will try and place the class in an auditorium over a lecture 

classroom as long as basic utilization requirements are being met). 

 And the rest of the feature (TV, Whiteboard, Computer, VCR/DVD, Data Port) – Weight 10  
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C. To begin another search for another subject or course simply clear your previously used filter by taking the 

following actions: 

a. Click on the “Home” tab or verify it is already selected. 

 
b. Click the “Sort & Filter” icon. 

 

 

c. Click “Clear”. 

 

Your list of preferences will now be a complete list.  If you did not cut out the data for the specific term you are 

needing, be sure to filter field “C” again to select the appropriate term.  You are now ready to begin your next 

search by repeating actions found in “PART 6”. 


